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1 Introduction 

1 Introduction 
 
This document is intended to provide instruction on how to use the Oztek Power Studio 
application (SW-90216). The application is a Microsoft Windows based Graphical User Interface 
(GUI) that provides the user a simple graphical interface for interacting with Oztek’s embedded 
power control products. This document is meant to provide installation instructions as well as 
detailed descriptions of the available features and how they can be applied in an engineering 
environment. 
 

1.1  Referenced Documents 
 

Ref. Document Description 

[1] FS-0046 OzCAN Protocol Functional Specification 

[2] www.modbus.org/specs.php Modbus Specification 

 

1.2  Definitions 
 

CAN Controller Area Network 

DSP Digital Signal Processor 

GUI Graphical User Interface 

XML Extensible Markup Language 

 

1.3 Requirements 

1.3.1 System Requirements 

The application requires the following hardware and software configuration: 
 

1. Microsoft Windows (7 or newer) based PC with an available USB port 
2. .NET (4.8 or higher) Runtime (available via http://www.microsoft.com ) 

1.3.2     Supported Protocols and Hardware 

1.3.1.1 CAN 

The application supports the OzCAN protocol (reference [1]), and the following CAN to USB 
hardware devices: 
 

Vendor Device 

Vector CANcaseXL 

Peak / Grid Connect PCAN-USB 

http://www.modbus.org/specs.php
http://www.microsoft.com/
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1.3.1.2 Modbus 

The application supports the Modbus RTU serial interface protocol (reference [2]) as well as 
Modbus TCP.  There are no vendor specific hardware requirements for serial Modbus.  
However, Power Studio has been tested and found to be compatible with the following devices: 
 

Vendor Device Description 

Advantech B+B USPTL4-LS USB to RS-485 Converter 

Anybus AB7702 Modbus RTU to TCP Gateway 

2 Installation Procedure 
 
Before installing Power Studio, be sure to install all the necessary drivers for the chosen 
communication device. For instructions on how to install the drivers, please refer to the 
product’s documentation. 
 
After successfully installing a communications device, launch the Power Studio installer by 
running the SW90216_setup_revMM_mm.exe executable. Note that MM represents major 
revision and mm minor revision. 

3 Overview 
 
Power Studio is an engineering tool that provides a standard interface to the many DSP-based 
power control products that Oztek produces. Examples of these products include Grid Tie / 
Active Front Ends (AFEs), Motor Controllers, and DC/DC converters. Power Studio supports 
communicating with multiple instances of a device. 
 
Power Studio consists of a main window with tabs that provide specific functionality such as 
“Dashboard,” “Instrumentation,” “Register Map,” “Software Upgrade,” and “Data Logging”. A 
menu bar is provided across the top of the window for configuring the tool.  
 

3.1 Target Profiles 
 
Power Studio is customized for a particular product using Target Profile files. Target Profiles are 
XML files used to configure Power Studio with the data, commands, and options that apply to a 
particular product. They are custom files that are provided by Oztek and can be found at 
www.oztekcorp.com. 
 

3.2 Configuration and Register Map Files 
 
Prior to version 5.0, Power Studio utilized Oztek Configuration files (.ozCfg) to document 
configuration register details including register addresses, data types, default, and user values.  
In version 5.0, Power Studio’s register access was expanded to include all product registers 
including volatile command and instrumentation registers in addition to the configuration 

http://www.oztekcorp.com/
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3 Overview 

registers. In doing so a new file type was created, Oztek Register Map files (.ozReg), which 
includes additional information to support the new features. 
 
Moving forward, Oztek will only provide register map files for new products. However, Power 
Studio does provide backward compatibility, allowing users to continue to use Oztek 
Configuration files for existing product families.  

 

3.3 Sessions 
 
Session files can be created to store communication settings when connecting to multiple 
devices. Using a session file saves the time of having to add each of the multiple Target Profiles 
every time the tool is started. Instead, a single session file can be loaded. Session files can also 
be used with a single device to store the loaded configuration or register map file, as well as 
real time graph setup. 
 

3.4 Basic View 
 

 

Figure 1 - Initial Launch 

 
When opening the tool, the main area is blank until either a Target Profile is loaded using the  
button on the shortcut bar, or Session file is loaded using the  button. The connection status 
is displayed in the bottom left corner. It will display “Disconnected” when not connected to a 
target and “Connected to <name of communication device>” when connected to a target. The 
colored circle indicates a more detailed status: 
 

• Green : Power Studio is communicating successfully with the target device 

• Orange : An error was detected in a reply from the target device 

• Red : Did not receive a reply from the target or Power Studio is disconnected from 
the target device 
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3.5 Getting Started 
 
To get started using the tool, follow these simple steps: 

• Click the  button on the shortcut bar and select the appropriate Target Profile for the 
product you are working with 

• Use the “Connection→Select Port” menu item to select the communication port you are 
using to interface with the product 

• Click on the  Connect button 

4 Menu Strip 
 
The menu strip contains menu items that allow the user to configure Power Studio. These items 
include loading a Session file, connecting to a target, configuring connection settings, and 
reading from and writing to individual registers. 
 

4.1 File Menu 
 
This menu contains options to load or save a Session file and close the GUI. Session files allow 
the user to save connection settings when connecting to multiple devices, as well as opened 
OzCfg or OzReg file options. 

4.1.1  Open Session 

This item is used to browse for and select a Session file that defines a list of target devices and 
their communication settings. Session files must be created by the user by adding targets via 
the  button on the shortcut bar, then using the “Save Session” menu item once the devices 
have been configured. See section 4.6.1 for details about adding target devices. 
 

 

Figure 2 - Open Session File 
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5 Menu Strip 

A panel on the left-hand side will appear if multiple targets are defined in the session. If 
supported, an Overview page is created with a summary of each device status and commands 
that are used to send broadcast messages to every device on the list simultaneously. 

4.1.2 Save Session 

This item saves a Session file containing information about each target that has been added. 
This can be used after every target device in a system is added to Power Studio to store the 
system configuration. 

4.1.3  Exit 

This item closes the GUI. It is identical to clicking the “X” in the top right-hand corner of the 
GUI. 
 

4.2 Connection Menu 
 
This menu contains options to connect to and disconnect from a target and configure 
connection parameters. 

4.2.1  Select Port 

This item is used to select a communication port to connect to a target device. It is disabled 
until a Target Profile is loaded. Once enabled, click on the port in the “Connection→Select Port” 
submenu to make a port selection. When a single port is found, it is automatically selected. If 
the desired connection port does not show up in the submenu, click “Connection→Select 
Port→Refresh” to get a new list of available ports. Once connected to a target, this item is 
disabled until the connection is disconnected.  

4.2.2 Connect 

This item is used to connect to a device via the selected communication port. Upon a successful 
connection, buttons and data that were previously disabled will be enabled and the GUI will 
start reading data from the target device. If no data appears, disconnect and check the 
connection settings under “Connection→Configure” or try connecting to another port. 

4.2.3  Disconnect 

This item is used to disconnect from a target. It is only available when connected to a target and 
it is disabled otherwise. 

4.2.4 Device ID 

This item is used to change the destination device ID.  
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4.2.5 Configure 

This menu item is used to change connection settings if needed. It should only have to be used 
if the target’s configuration has been changed from the default settings, as the default Target 
Profile should contain the correct information. Once the connection settings have been altered, 
click “Apply” to save the settings 

4.2.5.1 Modbus Settings 

 

Serial: 

• Device ID: the Modbus address of the target device 

• Baud Rate: the baud rate that matches the target device 

• Parity: the parity that matches the target device’s configuration 

• Stop Bits: the stop bits that match the target device’s configuration 

• Data Bits: how many data bits the target device expects per message 

• Handshake: if a handshake is required, this can set the handshake type 
 
RTU Over Ethernet/TCP: 

• Device ID: the Modbus address of the target device 

• IP Address: IP Address of the converter/gateway 

• Port: Port number 
 
If these settings are not correctly set from the Target Profile file, they can be found in the target 
device’s user manual or functional specification. 
 
 
 
 
 

Figure 3 - Example Modbus Settings 
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4.2.5.2 CAN Settings 

 

 

CAN: 

• Bit Rate: the bit rate that the target device is configured for 

• Source Module ID: the module ID of Power Studio 

• Source Group ID: the group ID of Power Studio 

• Destination Module ID: the module ID of the target device 

• Destination Group ID: the group ID of the target device 
 

J1939/Custom CAN: 

• Bit Rate: the bit rate that the target device is configured for 

• Msg ID Format: 11-bit or 29-bit message ID 

• Endianness: Little or Big Endian 

• Parameter Read/Write Request and Responses: Message ID’s for Oztek Parameter 
Read/Write request and response messages 

 
If these settings are not correctly set from the Target Profile file, they can be found in the target 
device’s user manual or functional specification. 

4.2.6 Connection Log 

The Connection Log Shows the number of successful messages, as well as the number of errors. 
 

Figure 4 - Example CAN Settings 
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The most common messages are: 
 

Message Meaning 

Success The message was received successfully 

No Response from Target Device A response to a message sent by Power Studio 
was not received from the target. Check the 
configured communication settings or cable 
hardware 

Illegal Data Address The PID or address that was requested is not 
valid in the register map 

Slave Device Failure The message could not be acted upon, most 
likely due to write data being out of range or 
an invalid password 

 
 

4.3 Tools Menu 
 
This menu contains other engineering tools that are not a main function of Power Studio. 

4.3.1  Register Read/Write 

This item allows reading from and writing to specific register addresses. It is only enabled when 
connected to a target device. 
 

Figure 5 - Register Read/Write Form 
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Password Section: The password section allows access to password-protected registers. If a 
password register is not defined in the Target Profile or if there are multiple password registers, 
a dropdown box will be displayed to input or select the password register address. 
 
Register Read Section: This section allows for a specific register to be read. Entering the 
register address in the “Address” textbox and clicking “Read Reg” will display the raw register 
value in the bottom textbox. If the “Show in Hex” checkbox is checked the result will be 
displayed in hex, otherwise it will be displayed in decimal. The success or failure status of the 
read will be displayed in the bottom status bar. 
 
Register Write Section: This section allows for a specific register to be written to. Enter the 
register address in the “Address” textbox, the value to write to it in the “Value” textbox, and 
click “Write Reg.” The success or failure status of the write will be displayed in the bottom 
status bar. Note that no scaling is applied to the value, so any required scaling needs to be 
considered when entering the number. 

4.3.2 Verify Config 

This item allows the user to compare a device’s configuration to a loaded OzCfg or OzReg file 
and will display a matching or non-matching result. This only compares configuration values, 
command and instrumentation registers are ignored. 
 
To use this feature, switch to the Register Map tab, open an OzCfg or OzReg file and connect to 
the target device. Once connected, click the “Tools→Verify Config” button and the tool will 
compare the device’s configuration to the loaded file. When completed, a message will be 
displayed with the results of the comparison. 

4.3.3 Real Time Graph 

The graphing tool provides a means to plot parameters live, while a target is operating. All the 
device registers defined in the OzReg file are available for plotting. Custom parameters can also 
be created where the user is allowed to apply scaling to display real world values or apply 
masks and shifts to display certain bits in bitfields. After a graph is stopped, values can be saved 
to a CSV file, or the graph can be saved as an image. Note that the graphing is only supported 
for products with a corresponding OzReg Register Map file. The graphing feature does not 
support OzCfg files. 
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Figure 6 – Real Time Graph Window 

 

4.3.3.1 Configure 

 
Use this menu item to configure the graph, including the amount of time to store data for and 
which parameters to graph. 
 

 

Figure 7 – Initial Graph Setup Form 
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Global Timing Configuration 
 
The “Global Timing Configuration” section configures the following: 

• Displayed Duration – The amount of time in seconds that is displayed on the live graph. 

• Stored Duration – The total amount of time in seconds to store data for. Since the 
amount of data displayed affects performance, set this longer than the Displayed 
Duration when larger amounts of data need to be captured but not all of it needs to be 
displayed at once. 

• Poll Rate – How often, in milliseconds, the list of parameters is polled. Faster poll rates 
will impact communication bandwidth. The fastest allowable poll rate is 50 milliseconds 
(20 Hz). 

 
Adding Parameters 
 
The menu section at the bottom of the Graph Setup window is used to select and add 
parameters to the graph. Selected parameters are displayed in the parameter table located in 
the middle of the window. If Power Studio is connected to multiple targets, the dropdown next 
to the “Target” label can be used to select the desired target. Once the desired target device is 
selected, click the “Browse” button and open the device’s OzReg file to populate the list of 
parameters to choose from.  
 

 

Figure 8 – Graph Setup 
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Click the checkboxes to add up to ten parameters to the graph. After being added, the Display 
Name can be changed as desired. In Figure 8, two parameters have been added to the graph, as 
displayed in the parameter table located in the middle of the window. As an example, the 
display name of the Cabinet Temperature has been changed to be more concise. 
 
Filters 
 
The radio buttons on the right can be used to display either command, instrumentation, or 
configuration parameters. Consult the target device’s user manual to determine a given 
parameter’s designation. 
 
The search box can be used to quickly find a desired parameter. Note that the search box 
ignores the radio button values and will display any parameter that matches the text. 
  
Custom Parameters 
 
Custom parameters can be created via the Custom Parameters button to apply scaling, bit 
shifting, and masking. Once created, they will show in the checklist all the way to the right. 
 

 

Figure 9 – Custom Parameters 

 
The plotted parameter is scaled according to the operator precedence in the following formula, 
in order from left to right: 
 

Display value = register value >> bitshift & mask x scale factor. 
 
In Figure 9, if a value of 500 is read from the “AC Current B” register, it would be multiplied by 
0.1 with 1 decimal place and be displayed as 50.0. Similarly, assume the “High AC Current 
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Warning” bit was bit 1 (0x2) of register 40131. Applying the Shift value of 1 and Mask of 0x1 
would right justify and isolate that bit in the register such that the displayed value would only 
ever be 0 or 1. 

4.3.3.2 Graphing 

 
After configuring the graph and clicking OK, the Real Time Graph window will display the 
selected parameters listed on the righthand side. The checkboxes next to the names can be 
used to show or hide each parameter. 
 

 
 
The Play button on the top bar enables live updating of the graph while the Stop button 
disables live updates. When stopped, sample points are displayed which, when hovered over, 
show the X and Y data for each sample. 
 
When stopped, the graph can be saved to a CSV file through the “File->Save Data to CSV” menu 
item, or to an image through the “File->Save Graph as Image” menu item. 
 
Zooming options will also become unlocked when the graph is stopped. Use the dropdown next 
to “All Graphs” on the toolstrip bar to select which parameters the zooming buttons will affect.  
 

•   When this is selected (surrounded by a blue square), scrolling with the mouse wheel 
and dragging the mouse affects the X axis 

•   When this is selected (surrounded by a blue square), scrolling with the mouse wheel 
and dragging the mouse affects the Y axis 
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•   Zoom in on the selected axis 

•   Zoom out on the selected axis 

•   Shift the data to the left 

•   Shift the data to the right 

•   Shift the selected data up 

•   Shift the selected data down 

•   Reset the zoom on the selected parameter and axis 
 

If more than the displayed amount of data is captured (Stored Duration is greater than 
Displayed Duration), select the horizontal arrows and use either the mouse or shift buttons to 
scroll through previous data. 
 

4.4 View Menu 
 
This menu contains items used to show or hide components on the GUI. 

4.4.1 Target List 

This item shows or hides the list of target devices that have been added to the session on the 
left-hand side of the GUI. The list allows the user to switch to different devices. 
 

4.5 Help Menu 
 
This menu contains items used to display information about Power Studio. 

4.5.1  About 

This item displays the Oztek part number, version, and description of Power Studio. 

4.5.2 User Manual 

This item opens this User Manual. 
 

4.6 Shortcut Menu Strip 
 
The Shortcut Strip provides shortcut buttons for common tasks as follows: 

• : File→Open Session 

• : Connection→Connect 

• : Connection→Disconnect 

• : Help→User Manual 
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4.6.1 Add/Remove Target 

Use the  and  buttons to add and remove targets respectively. Adding a target will 
prompt for a Target Profile file location and will allow the user to configure connection settings. 
The dropdown menu adjacent to these buttons provides a means to select a target to 
communicate with from a list of targets in the session. 
 
Target Profile files define fault, warning, command, instrumentation, and connection data for 
each target device in a system. The data in this file is loaded into the tool and is used to query 
the target.  
 

 

 
When a Target Profile is opened, the GUI is populated with fields specific to that target. Most of 
the populated GUI items will be disabled (grayed out) until connected to a target. 

5 Dashboard 
 
The Dashboard tab is split up into four sections: Faults, Warnings, Status, and Commands. It is 
meant to provide general target device status and displays basic overall operational 
information. The selection of what data is displayed on this tab is defined in the Target Profile 
file provided by Oztek. 
 

Figure 10 - Target Profile Opened 
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Fault Section: This section is used to display active faults on the target device. Active faults are 
displayed on individual lines in red. If no faults are active, “No Faults” will be displayed in green. 
 
Warning Section: This section is used to display active warnings on the target device. Active 
warnings are displayed on individual lines in orange. If no warnings are active, “No Warnings” 
will be displayed in green. 
 
Status Section: This section is used to display the main instrumentation data on the target 
device. It is split up into three columns: register description, value, and units. Values are either 
raw register values, enumerated values, or scaled values depending on input from the Target 
Profile. These values are updated at a rate specified in the Target Profile. 
 
Command Section: This section allows specific commands to be sent to the target device. There 
are three types of command controls: button, textbox, and dropdown.  

• Button: Sends a single value to a specific register 

• Textbox: Sends the numeric value entered into the textbox when the corresponding 
button is clicked. This value is checked against minimum and maximum values, scaled to 
match what the target device expects, and then sent out if it passes the min/max check 

• Dropdown: Sends a value to a specific register based on the chosen enumerated value 
when the corresponding button is clicked 
 
 

Figure 11 - Active Dashboard 
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6 Instrumentation 
 
The Instrumentation tab is used for displaying instrumentation data in more detail than what 
may be shown on the Dashboard tab. The parameters displayed on this tab are specified in the 
Target Profile file. Items are disabled and not updated when disconnected from a target device. 
 

 

 
Instrumentation values are displayed on this tab using multiple sections. Each section is split up 
into three columns: register description, value, and units. Values are either enumerated values, 
raw register values, or scaled values. These values are updated at a rate specified in the Target 
Profile. 
 

7 Register Map 
 
The Register Map tab allows viewing and modifying parameters within the target itself. These 
parameters are read in through an Oztek Config (.ozCfg) file or a Register Map (.ozReg) file 
provided by Oztek. Consult the product’s user manual or functional specification for details 
regarding a particular target device’s register map. Note that when first switching to the 
Register Map tab, some options are disabled until the tool is connected to a target device. 
 
 

Figure 12 - Active Instrumentation 
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7.1  Open File 
 
This button is used to browse for and open an OzCfg or OzReg file which is used to populate the 
list of available registers. The file may take several seconds to open. 
 

 

Figure 14 – Configuration File Opened when Disconnected from Target 

 

Figure 13 - Initial Register Map Tab 



 

Publication UM-0052 

19 Register Map 

After a file is opened, its name is displayed above the “Save to File” button. If not connected to 
a target, the resulting Device’s Value column will contain “---.“ 
 

 

Figure 15 – Register Map File Opened when Disconnected from Target 

 
OzReg files are more comprehensive than OzCfg files and display header groups for parameters. 
The “+” and “-“ symbols to the left headers may be clicked to expand and collapse groups. The 
file opens with all groups collapsed, as shown in Figure 15. 
 

 

Figure 16 – Register Map When Connected to Target 
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Once connected, Power Studio will read each of the parameters displayed in the window and 
display the result. If a Configuration value in the Edit Value column does not match a value read 
from the target and displayed in the Device’s Value column, the value in the Edit Value column 
will be displayed in red. Parameters that are read-only do not show a value in the Edit Value 
column and cannot be written to. 
 

7.2  Save to File 
 
This button allows the user to save an OzCfg or OzReg file based on the file type that was 
originally opened. Files can be saved with either the Edit Value column to capture custom user 
settings or the Device’s Value column to capture the target device’s settings. Note that when 
saving device settings, all device values must be read, which may take a minute or longer on 
some targets. 
 

7.3  Writing Single Values 
 
To write a single value to the target, enter the desired value in the Edit Value column and leave 
the cell or press “Enter.” The value will be checked against the minimum and maximum values 
and then it will be sent to the device if it passes the check. After the value is written, it will be 
read back and displayed in the Device’s Value column. The target must be connected to write 
values. Note that some products include registers that only update working values on power 
up. For these registers the “Reboot Target Device” button will need to be pressed or power will 
need to be cycled for changes in the target’s operational control variables to take effect. 
Consult your products User Manual to identify registers with this constraint. 
 

7.4  Write All 
 
The “Write All” button will attempt to write all Configuration values in the Edit Value column to 
the device. This is useful when commissioning a product by loading a previously saved, custom 
configuration. Generally, it is good practice to press the “Reboot Target Device” button or cycle 
power after performing a “Write All” to ensure all changes take effect. 
 

7.5  Reboot Target Device 
 
Pressing this button sends the “Configuration Reload” command which causes the target to 
load the configuration parameters from non-volatile memory into the internal operating 
control variables in RAM. 
 

7.6  Restore Defaults 
 
This button sends the “Restore Defaults” command to the device. This causes the device to 
reset all configuration parameters back to their factory default settings. Pressing this button 
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resets the Device’s Value column. Note that this command may require a password to be typed 
into the Password textbox. 
 

7.7  Filter Options 
 
The “Filter Options” section allows the user to selectively show or hide parameters either by 
specifying key words in the Description column or by selecting which register type or group to 
show. 

7.7.1 Show Filter 

Use the textbox to show only the parameters that contain the text in the Description column. 
For example, typing “Volt” will display any parameters that contain “Volt” in the description 
and still match the rest of the filter options. 

7.7.2 Register Type 

These radio buttons filter on the Register Type column in the grid view. The options are to show 
all parameters or only ones that are Configuration values. 

7.7.3 Basic/Advanced Checkboxes 

These checkboxes toggle the visibility of basic and advanced parameters. Parameters can be 
grouped into basic parameters which change generic operational settings and advanced 
parameters which change specific application-related settings. Advanced parameters will show 
up in Power Studio as a different color than basic parameters (blue). See a product’s user 
manual for a list of parameters in each group. If a user manual does not mention these groups, 
it is assumed all the parameters are basic parameters. 

7.7.4 Expand and Collapse All 

Use these buttons to expand or collapse all header groups when using an OzReg file. These 
buttons have no effect when using an OzCfg file. 

8 Software Upgrade 
 
The Software Upgrade tab is used to download an application using the target’s embedded 
bootloader. 
 
The steps to download an image are as follows and are expanded upon within this section: 
1. Connect to a communication port. 
2. Select an image to download. 
3. Download an image. 
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Figure 17 - Software Upgrade Tab 

 

8.1 Selecting an Image to Download 
 
Use the “Browse” button to browse for and select an image to download. The selected file 
should be in the format of “SW90***_revX_Y.out” or “SW90***_revX_Y.hex” where *** is the 
Oztek software number, X is the major software revision, and Y is the minor software revision. 
The selected file path will be shown in the textbox next to the “Browse” button. 
 

8.2 Using the Bootloader 
 
The target’s embedded bootloader can be launched using one of two possible methods 
depending on what the device supports: 
 
1. With the device powered off, connect to the communication port using the 

“Connection→Connect” menu item. With an image selected, click “Download” and the text 
“Searching for Bootloader…” will appear in the middle of the GUI. Wait 4 seconds and 
power on the device and the bootloader should run and connect. 

2.  
3. While the device is powered on but not running, use the “Connection→Connect” menu 

item to connect to the device’s communication port. With an image selected, click 
“Download” and the text “Searching for Bootloader…” will appear in the middle of the GUI 
and the bootloader will be launched. If the bootloader does not connect and the “Searching 
for Bootloader…” text persists, then the device may not support this method and method 1 
will have to be used. Figure 18 illustrates Power Studio searching for the bootloader. 
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Figure 18 - Searching for Bootloader 

 
Once Power Studio connects to a bootloader, the bootloader version is displayed, and the 
download process starts automatically. 
 
The download consists of two phases: Clearing Memory and Programming. A progress bar is 
shown during each phase. 
 

 

Figure 19 - Clearing Memory Phase 
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Figure 20 - Programming Phase 

If an error occurs during either of these phases, it is displayed in the middle of the GUI. 
Otherwise, “Programming Completed” is shown. 
 

 

Figure 21 - Programming Completed 

 
Once a download is complete, the downloaded application is automatically launched. If the 
application does not launch within a few seconds, the target will need to be power cycled for it 
to run. 
 
If an error is detected during programming, a Clear Memory command will be sent to wipe the 
target device of any partial image. If this happens, check the physical device connections, and 
try downloading the application image again. 
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9 Data Logging 
 
The Data Logging tab is only visible if the target device supports the data logging features. The 
various features are listed on the left-hand side and only the supported features are enabled. 
 

9.1 Fault Log 
 
The Fault Log reads a log consisting of samples taken when a fault occurs. The number of 
samples captured before or after a fault occurs is device-specific, as well as the maximum 
number of logs that can be stored. 
 

 

Figure 22 - Fault Log 

 
A log header is read and displayed across the top of the log detailing the date and time of the 
fault as well as the number of samples (rows) captured. A timeline is shown in the first column. 
Positive numbers indicate the time in seconds after the fault occurred and negative numbers 
indicate the time before the fault. 
 
The controls are shown on the right-hand side, along with the number of logs currently stored 
on the device. Use the “Get Log List” button to read the timestamp for each log and select 
which log to read using the dropdown menu. Reading a log can be paused and resumed and the 
log can be saved to a CSV file once reading is completed. 
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9.2 User Log 
 
The User Log allows the user to collect data based on a configurable event. This data is stored in 
volatile memory so it will not persist between device POR’s. 
 

 

Figure 23 - User Log 

 
Like the Fault Log, the User Log displays a log header above the table of data detailing the date 
and time as well as the number of samples (rows) captured. 
 
Log controls are located on the right-hand side and the status of the data logger is displayed. 
Use the “Run” button to arm the log and “Stop” button to force it to stop logging. This log can 
be read with the “Read Log” button and the “Save Log” button can be used to save the data to 
a CSV file after reading is completed. 
 
The Log Status shows the current state of the User Log: 

• Idle: The log is waiting to be armed 

• Running (Pre-Trigger): The log is waiting for the trigger to occur 

• Running (Post-Trigger): A trigger has occurred, and post-trigger data is being captured 

• Finished: The log has finished capturing data and is ready to be read or rearmed 
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9.2.1 Configure Trigger 

Up to two events can be configured as triggers to capture data. Data that is stored can be a mix 
of before and after the trigger occurs. 
 

 

Figure 24 - User Log Trigger Configuration 

 
The “Get Device Values” button can be used to query the device and fill in the fields for the 
currently selected configuration. 
 

• Trigger Mode: Selects the number of trigger events to use 
o Continuous: No trigger. Data is always being logged until the “Stop” button is 

pressed 
o Single: Only the criteria for Trigger 1 is used as an event to capture data 
o Trigger 1 OR Trigger 2: Captures data when the criteria for either Trigger 1 or Trigger 

2 is met 
o Trigger 1 AND Trigger 2: Captures data when the criteria for both Trigger 1 and 

Trigger 2 are met simultaneously 

• Post Trigger %: The percentage of the maximum number of samples to store after the 
trigger occurs. This varies by target device 

• Sample Period: The time in milliseconds between samples 

• Trigger 1 and 2: Sets up the events for each trigger.  The variable and value threshold to 
trigger on can be set and specific bits can be masked 

 
 
 
Use the “Set Trigger Values” button to send the configuration to the device. 
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9.2.2 Select Variables 

This form allows the user to select which variables get stored in the log. The number of samples 
stored depends on how many variables are selected. 
 

 

Figure 25 - User Log Variable Selection 

Use the “Get Device Values” button to retrieve the currently selected variables on the target 
device. Once the requested variable checkmarks are checked, use the “Set Variable Selection” 
button to send the configuration to the device. 
 

9.3 Operating History 
 
The Operating History log consists of three categories which store data over the life of the 
device. The categories can be accessed via the tabs at the top of the window. 
 
The controls are on the right-hand side of the GUI. The “Read Log” and “Save Log” buttons read 
data and save data from the currently selected log. 

9.3.1 Durations 

This log stores the amount of time the device has spent at each operating point in seconds. 
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Figure 26 - Operation Log Durations 

9.3.2 Fail Counts 

This log stores the number of times each fault has occurred over the life of the device. 
 

 

Figure 27 - Operation Log Fault Counts 
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9.3.3 Min/Max Data 

This log stores the minimum and maximum values of various measurements over the life of the 
device. 

 

Figure 28 - Operation Log Min/Max Data 

9.4 Fault History Log 
 
This log shows the timestamps of the last few occurrences of each fault.  The number of 
timestamps stored may vary by product. 
 

 

Figure 29 - Fault History Log 

The timestamps are read left to right from most recent to least recent and can be read and 
saved via the buttons on the right. 
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10 About 
 
The About tab displays information regarding both Power Studio and the Target. Older TPR files 
do not have support for this page and will only display Power Studio information. 
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Warranty and Product Information 

Limited Warranty 
What does this warranty cover and how long does it last? This Limited Warranty is provided by Oztek Corp. 

("Oztek") and covers defects in workmanship and materials in Oztek products. This Warranty Period lasts for 18 
months from the date of purchase at the point of sale to you, the original end user customer, unless otherwise 
agreed in writing. You will be required to demonstrate proof of purchase to make warranty claims.  This Limited 
Warranty is transferable to subsequent owners but only for the unexpired portion of the Warranty Period.  
Subsequent owners also require original proof of purchase as described in "What proof of purchase is required?" 
 

What will Oztek do? During the Warranty Period Oztek will, at its option, repair the product (if economically 

feasible) or replace the defective product free of charge, provided that you notify Oztek of the product defect 
within the Warranty Period, and provided that through inspection Oztek establishes the existence of such a defect 
and that it is covered by this Limited Warranty. 
 
Oztek will, at its option, use new and/or reconditioned parts in performing warranty repair and building 
replacement products. Oztek reserves the right to use parts or products of original or improved design in the repair 
or replacement. If Oztek repairs or replaces a product, its warranty continues for the remaining portion of the 
original Warranty Period or 90 days from the date of the return shipment to the customer, whichever is greater. All 
replaced products and all parts removed from repaired products become the property of Oztek. 
 
Oztek covers both parts and labor necessary to repair the product, and return shipment to the customer via an 
Oztek-selected non-expedited surface freight within the contiguous United States and Canada. Alaska, Hawaii and 
locations outside of the United States and Canada are excluded. Contact Oztek Customer Service for details on 
freight policy for return shipments from excluded areas. 
 

How do you get service? If your product requires troubleshooting or warranty service, contact your merchant. If 

you are unable to contact your merchant, or the merchant is unable to provide service, contact Oztek directly at: 
 

USA 
Telephone: 603-546-0090 
Fax: 603-386-6366 
Email techsupport@oztekcorp.com  

 
Direct returns may be performed according to the Oztek Return Material Authorization Policy described in your 
product manual. 
  

What proof of purchase is required? In any warranty claim, dated proof of purchase must accompany the 

product and the product must not have been disassembled or modified without prior written authorization by 
Oztek.  Proof of purchase may be in any one of the following forms: 
 
• The dated purchase receipt from the original purchase of the product at point of sale to the end user 
• The dated dealer invoice or purchase receipt showing original equipment manufacturer (OEM) status 
• The dated invoice or purchase receipt showing the product exchanged under warranty 

 
What does this warranty not cover? Claims are limited to repair and replacement, or if in Oztek's discretion 

that is not possible, reimbursement up to the purchase price paid for the product. Oztek will be liable to you only 
for direct damages suffered by you and only up to a maximum amount equal to the purchase price of the product. 
This Limited Warranty does not warrant uninterrupted or error-free operation of the product or cover normal 
wear and tear of the product or costs related to the removal, installation, or troubleshooting of the customer's 
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electrical systems. This warranty does not apply to and Oztek will not be responsible for any defect in or damage 
to: 
 

a) The product if it has been misused, neglected, improperly installed, physically damaged or altered, 
either internally or externally, or damaged from improper use or use in an unsuitable environment 
b) The product if it has been subjected to fire, water, generalized corrosion, biological infestations, or 
input voltage that creates operating conditions beyond the maximum or minimum limits listed in the 
Oztek product specifications including high input voltage from generators and lightning strikes 
c) The product if repairs have been done to it other than by Oztek or its authorized service centers 
(hereafter "ASCs") 
d) The product if it is used as a component part of a product expressly warranted by another 
manufacturer 
e) The product if its original identification (trade-mark, serial number) markings have been defaced, 
altered, or removed 
f) The product if it is located outside of the country where it was purchased 
g) Any consequential losses that are attributable to the product losing power whether by product 
malfunction, installation error or misuse. 
 

Disclaimer 
Product 
THIS LIMITED WARRANTY IS THE SOLE AND EXCLUSIVE WARRANTY PROVIDED BY OZTEK IN CONNECTION WITH YOUR OZTEK PRODUCT AND IS, 
WHERE PERMITTED BY LAW, IN LIEU OF ALL OTHER WARRANTIES, CONDITIONS, GUARANTEES, REPRESENTATIONS, OBLIGATIONS AND 
LIABILITIES, EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE IN CONNECTION WITH THE PRODUCT, HOWEVER ARISING (WHETHER BY 
CONTRACT, TORT, NEGLIGENCE, PRINCIPLES OF MANUFACTURER'S LIABILITY, OPERATION OF LAW, CONDUCT, STATEMENT OR OTHERWISE), 
INCLUDING WITHOUT RESTRICTION ANY IMPLIED WARRANTY OR CONDITION OF QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE TO THE EXTENT REQUIRED UNDER 
APPLICABLE LAW TO APPLY TO THE PRODUCT SHALL BE LIMITED IN DURATION TO THE PERIOD STIPULATED UNDER THIS LIMITED WARRANTY. 
IN NO EVENT WILL OZTEK BE LIABLE FOR: (a) ANY SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, 
LOST REVENUES, FAILURE TO REALIZE EXPECTED SAVINGS, OR OTHER COMMERCIAL OR ECONOMIC LOSSES OF ANY KIND, EVEN IF OZTEK HAS 
BEEN ADVISED, OR HAD REASON TO KNOW, OF THE POSSIBILITY OF SUCH DAMAGE, (b) ANY LIABILITY ARISING IN TORT, WHETHER OR NOT 
ARISING OUT OF OZTEK'S NEGLIGENCE, AND ALL LOSSES OR DAMAGES TO ANY PROPERTY OR FOR ANY PERSONAL INJURY OR ECONOMIC LOSS 
OR DAMAGE CAUSED BY THE CONNECTION OF A PRODUCT TO ANY OTHER DEVICE OR SYSTEM, AND (c) ANY DAMAGE OR INJURY ARISING 
FROM OR AS A RESULT OF MISUSE OR ABUSE, OR THE INCORRECT INSTALLATION, INTEGRATION OR OPERATION OF THE PRODUCT.  IF YOU ARE 
A CONSUMER (RATHER THAN A PURCHASER OF THE PRODUCT IN THE COURSE OF A BUSINESS) AND PURCHASED THE PRODUCT IN A MEMBER 
STATE OF THE EUROPEAN UNION, THIS LIMITED WARRANTY SHALL BE SUBJECT TO YOUR STATUTORY RIGHTS AS A CONSUMER UNDER THE 
EUROPEAN UNION PRODUCT WARRANTY DIRECTIVE 1999/44/EC AND AS SUCH DIRECTIVE HAS BEEN IMPLEMENTED IN THE EUROPEAN UNION 
MEMBER STATE WHERE YOU PURCHASED THE PRODUCT. FURTHER, WHILE THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, YOU 
MAY HAVE OTHER RIGHTS WHICH MAY VARY FROM EU MEMBER STATE TO EU MEMBER STATE OR, IF YOU DID NOT PURCHASE THE PRODUCT 
IN AN EU MEMBER STATE, IN THE COUNTRY YOU PURCHASED THE PRODUCT WHICH MAY VARY FROM COUNTRY TO COUNTRY AND 
JURISDICTION TO JURISDICTION. 
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Return Material Authorization Policy 
Before returning a product directly to Oztek you must obtain a Return Material Authorization (RMA) number and 
the correct factory "Ship To" address. Products must also be shipped prepaid. Product shipments will be refused 
and returned at your expense if they are unauthorized, returned without an RMA number clearly marked on the 
outside of the shipping box, if they are shipped collect, or if they are shipped to the wrong location. 
When you contact Oztek to obtain service, please have your instruction manual ready for reference and be 
prepared to supply: 
 

• The serial number of your product 
• Information about the installation and use of the unit 
• Information about the failure and/or reason for the return 
• A copy of your dated proof of purchase 

 

Return Procedure 
Package the unit safely, preferably using the original box and packing materials. Please ensure that your product is 
shipped fully insured in the original packaging or equivalent. This warranty will not apply where the product is 
damaged due to improper packaging. Include the following: 
 

• The RMA number supplied by Oztek clearly marked on the outside of the box. 
• A return address where the unit can be shipped. Post office boxes are not acceptable. 
• A contact telephone number where you can be reached during work hours. 
• A brief description of the problem. 
 

Ship the unit prepaid to the address provided by your Oztek customer service representative. 
 

If you are returning a product from outside of the USA or Canada - In addition to the above, you MUST 

include return freight funds and you are fully responsible for all documents, duties, tariffs, and deposits. 

 

Out of Warranty Service 
If the warranty period for your product has expired, if the unit was damaged by misuse or incorrect installation, if 
other conditions of the warranty have not been met, or if no dated proof of purchase is available, your unit may be 
serviced or replaced for a flat fee. If a unit cannot be serviced due to damage beyond salvation or because the 
repair is not economically feasible, a labor fee may still be incurred for the time spent making this determination. 
 
To return your product for out of warranty service, contact Oztek Customer Service for a Return Material 
Authorization (RMA) number and follow the other steps outlined in "Return Procedure".   
 
Payment options such as credit card or money order will be explained by the Customer Service Representative. In 
cases where the minimum flat fee does not apply, as with incomplete units or units with excessive damage, an 
additional fee will be charged. If applicable, you will be contacted by Customer Service once your unit has been 
received. 

 


